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Introduction

Welcome toMastercam Tool Manager Tutorial. This guide provides information about
Mastercam's stand-alone Tool Manager. Some of the information is in a step-by-step
format, and some of the information is in a paragraph format. Both formats walk you
through how and when to use the stand-alone Tool Manager.

Tutorial Goals
l Become familiar with Mastercam’s stand-alone Tool Manager

l Work with tool libraries (.TOOLDB) and their components

l Create and edit tools and holders in Mastercam’s classic Tool Manager

l Properly render imported tools

WARNING: Screen colors in the tutorial pictures were modified to enhance
image quality; they may not match your Mastercam settings or the tutorial
results. These color differences do not affect the lesson or your results.

Estimated time to complete this tutorial: 3 hours

General Tutorial Requirements
All Mastercam 2018 tutorials have the following general requirements:

l Youmust be comfortable using the Windows® operation system.

l The tutorials cannot be used with Mastercam Demo/Home Learning Edition.
The Demo/HLE file format (emcam) is different fromMastercam (mcam), and
basic Mastercam functions, such as file conversions and posting, are unavail-
able.

Mastercam ToolManager Tutorial— Introduction



l Each lesson in the tutorial builds on the mastery of the preceding lesson's
skills. We recommend that you complete them in order.

l Additional files may accompany a tutorial. Unless the tutorial provides specific
instructions on where to place these files, store them in a folder that can be
access from the Mastercam 2018 workstation, either with the tutorial or in any
location that you prefer.

l You will need an internet connection to view videos that are referenced in the
tutorials. All videos can be found on our YouTube channel:
www.youtube.com/user/MastercamTechDocs

l All Mastercam tutorials require you to configure Mastercam to work in a
default metric or English configuration. The tutorial provides instructions for
loading the appropriate configuration file.

Mastercam ToolManager Tutorial— Introduction
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Mastercam's Tool Manager

Mastercam's stand-alone Tool Manager provides an efficient and comprehensive way
to manage tools and tool holding components, and to create tool assemblies to use in
Mastercam. Besides the tooling component support, Tool Manager also integrates
workmaterial and cut parameter data so that you can accommodate a man-
ufacturer's cutting recommendations or create your own cut parameter data and
store it in the database.

Launch the stand-alone Tool Manager separately fromMastercam by choosing Tool
Manager from your Start menu's Mastercam folder. Certain Tool Manager functions
are integrated into the Mastercam interface and are launched from within Mastercam
when you create new tools, holders, and assemblies. While you are in Tool Manager,
your data is automatically saved as you work.

Tool Manager Interface
This section contains brief descriptions of the stand-alone Tool Manager interface.

Mastercam ToolManager Tutorial—Mastercam's ToolManager



1. Tabs: Tabs function somewhat like dialog boxes but look similar to toolbars.
You cannot undock or dock a tab, nor are they customizable.

2. Database Explorer: Use the Tool Manager Database Explorer to access con-
tent in tool database files (TOOLDB). Right-click an item to expand or collapse
it. To work with items in the database tree view (i.e., Cutting Tools, Tool Assem-
blies, Holders, Materials, and Cut Parameters), double-click the item.

3. Assembly Tree: Use the Assembly Tree to open, create, and edit assemblies
in the open TOOLDB database. Tool Assemblies may contain one tool and one
or more holder components. Use the Assembly Tree to navigate the individual
assembly items. If you double-click on Tool Assemblies in the Database
Explorer or choose Assembly on the Home tab, the Assembly Tree appears
below the Database Explorer and the Assemblies document appears in the doc-
uments area.

4. Document Datagrids: Tool Manager uses "documents" to organize data such
as tools, holders, and assemblies. The main workspace uses a tab-style inter-
face to present these documents.

Mastercam ToolManager Tutorial—Mastercam's ToolManager
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5. Graphics Window: The graphics window is part of a document, and displays
what you have selected in the document datagrid. For example, if you are work-
ing in the Assembly document, the graphics window displays the assembly you
have selected in the datagrid.

6. Properties Grid: Tool Manager Properties Grid displays properties for cutting
tools, assemblies, holders, extensions, materials, and cutting parameters. The
properties displayed in the Properties Grid depend on which document type
you have open and which item you have selected in the document.

Stand-Alone vs. Classic Tool Managers
Although this document focuses on the stand-alone Tool Manager, Mastercam offers
more than one Tool Manager to create, edit, andmanage your tools, tooling com-
ponents, and tool libraries. Each Tool Manager is accessed with different workflows
and circumstances.

Stand-Alone Tool Manager

Mastercam ToolManager Tutorial—Mastercam's ToolManager



The stand-alone Tool Manager provides an interface to manage Mill and Router tools
and tool holding components, and to create tool assemblies to use in Mastercam. In
addition to the tooling component support, Tool Manager also integrates workmater-
ial and cut parameter data so that you can accommodate a manufacturer’s cutting
recommendations. You can also create your own cut parameter data and store it in
the database.

Classic Mill/Router Tool Manager

The classic Mill/Router Tool Manager allows you to view andmanage tool libraries,
the tools in your part file, and tool definitions. Use it to:

l View tools stored in a tool library, machine group, or both.

l Create new tools and store them in a tool library or machine group.

l Copy tools to/from a library to a machine group, or between different libraries
or machine groups.

Mastercam ToolManager Tutorial—Mastercam's ToolManager
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The Mill Tool Manager is accessed by selecting Tool Manager on theMill or Router
contextual tab.

Classic Lathe Tool Manager

The classic Lathe Tool Manager has the same features as the classic Mill/Router Tool
Manager.

The LatheTool Manager is accessed by selecting Tool Manager on the Lathe Turn-
ing orMilling contextual tab.

Mastercam ToolManager Tutorial—Mastercam's ToolManager



Working with the Stand-Alone Tool Manager
By using the stand-alone Tool Manager instead of the Classic Mill or Lathe Tool Man-
ager, you can do the following:

l Work without Mastercam open: Although you need to have Mastercam
installed to run the stand-alone Tool Manager, you do not have to have Master-
cam open. You don’t even need to have a SIM plugged in. When you create,
edit, and organize your tool libraries without runningMastercam, you increase
your computer’s performance while reserving that licensedMastercam seat
for someone else.

l Search: You can search for tools, assemblies, and other components that
match your search criteria. You can save searches for future use as Favorites
and you can view recent searches.

l Copy components between libraries: You can copy tools, holders, and
assemblies from one TOOLDB to another, open the different tool libraries in
separate instances of Tool Manager and drag and drop the tooling component
from one Tool Manager to the other.

l Create and edit assemblies: You can create and edit tooling assemblies. You
can drag and drop assembly components into the Assembly Tree, you can
work directly in the Tool Manager’s graphics window to edit assemblies, and
you can change the parameters for an assembly or for each of the assembly
components in the Properties Grid.

l Customizable workspace - The workspace of the stand-alone Tool Manager
allows you to undock the major interface objects. This is useful if you work with
multiple monitors. It is also useful if you just want to reposition or hide the inter-
face windows to suit your preferences.

l Create and edit materials and cut parameters: Tool Manager allows you to
create and edit materials and cut parameters. These settings are stored in the
tool library and are easily accessed throughMastercam when you create or
edit a tool with the Tool Wizard.

Mastercam ToolManager Tutorial—Mastercam's ToolManager
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l Edit multiple components: You to select multiple document items, such as
multiple tools, and edit the properties for all selected items with the Properties
Grid.

In this tutorial, you will go through some of these concepts in the next few chapters.

Recommended Workflow
The stand-alone Tool Manager is designed to create tool libraries (TOOLDB) that can
be specific to a job and/or machine. These tool libraries can be used as part of a job
“kit” that reside on one machine, or travel with the part.

The recommended workflow is to set up your tool libraries using the stand-alone Tool
Manager, and then use those libraries in Mastercam to apply to specific jobs, parts,
andmachines.

After installing Mastercam, youmust openMastercam before opening the stand-
alone Tool Manager for the first time, so that it can build support files. After opening
Mastercam, you can close it and successfully open the stand-alone Tool Manager. If
you are working from a newMastercam install and try to open the stand-alone Tool
Manager without at least opening and closingMastercam, you will receive an error
message prompting you to openMastercam.

Mastercam ToolManager Tutorial—Mastercam's ToolManager
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Working with Tool Library Files

(.TOOLDB)

In this lesson, you learn how to work with tool libraries.

Lesson Goals
l Switch to metric database output

l Create and edit tool libraries

l Use the stand-alone Tool Manager's Search feature

1



Exercise 1: Creating Tool Libraries
In this exercise, you learn to create tool libraries by either copying an existing library
or creating a TOOLDB from scratch. Because you create metric tools and holders
later in this guide, you set the default units to metric in this exercise.

The default unit setting is read fromMastercam’s System Configuration.

Tool Manager remains in the metric state until youmanually change it back to inch,
even if you use multiple sessions of Tool Manager or turn off your computer.

All new tools and holders created in the stand-alone Tool Manager or from within
Mastercam, are created usingmetric values until this option is changed back to inch
units.

You can have both inch andmetric tooling components in the same library (.TOOLDB
file).

Creating a Tool Library from an Existing Library

1. If the stand-alone Tool Manager is not already running, Open Tool Manager
from your Mastercam folder in the Windows’ Start menu.

2. Open ToolManagerTutorial.tooldb, provided with this tutorial.

3. After the tool library loads, click the File tab (backstage view) and choose
Options.

Mastercam ToolManager Tutorial—1: Working with Tool Library Files (.TOOLDB)
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4. In the Application Options dialog box, choose the General page.

5. If it’s not already selected, set Default units toMetric.

6. ClickOK.

7. Select File, Save As.

Mastercam ToolManager Tutorial—1: Working with Tool Library Files (.TOOLDB)



8. Save the TOOLDB as ToolManagerTutorial_XXX.tooldb, where XXX
are your initials. You save the library with a different file name so that you do
not overwrite the file provided with this guide.

Mastercam ToolManager Tutorial—1: Working with Tool Library Files (.TOOLDB)
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Creating a New Tool Library from Scratch

1. Select File,New, Tool Database.

This opens a second instance of Tool Manager.

2. In the Save As dialog box, enter a new file name of your choice and click Save.

Note: As you work in Tool Manager, your changes are automatically saved to
the database.

3. Close both sessions of Tool Manager. Save any changes if prompted.

Exercise 2: Opening and Editing a Tool Library
In this exercise, you open an existing library in Tool Manager and edit one or more of
its components.

1. Open the stand-alone Tool Manager.

2. SelectOpen and navigate to the ToolManagerTutorial_XXX.tooldb

Mastercam ToolManager Tutorial—1: Working with Tool Library Files (.TOOLDB)



file you created in the previous exercise.

3. Open each of the document types by double-clicking its library component in
the Database Explorer.

4. You should have the following documents open:

5. Review the buttons in the New Component,New Milling, andNew Hole
Making groups. Hover your mouse over each icon to view a pop-up tooltip.

Below the following graphic are brief descriptions of each item.

l Holder: Puts focus on the Holders document, and opens the Holder Wiz-
ard where you can create a new holder and add it to the library

Mastercam ToolManager Tutorial—1: Working with Tool Library Files (.TOOLDB)
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database.

l Assembly: Puts focus on the Assemblies document, and opens the
Assembly Tree where you can create a new assembly.

l Material: Puts focus on the Materials document, adds a blank row, and
allows you to create a newmaterial by defining its properties in the Prop-
erties Grid.

l Cut Parameter: Puts focus on the Cut Parameters document, adds a
blank row, and allows you to create a new cut parameter by defining its
properties in the Properties Grid.

l New Milling: Puts focus on the Tools document and opens the Tool Wiz-
ard where you can create a newmilling tool.

l New Hole Making: Puts focus on the Tools document and opens the
Tool Wizard where you can create a new hole-making tool.

Single-click an item in a document to edit its parameters in the Prop-
erties Grid. Alternatively, double-click any tool or holder to open the Tool
Wizard or Holder Wizard where you can edit parameters. You can also
edit assemblies in the Assembly Tree. Edits youmake in the Assembly
Tree update the parameters in the Properties Grid.

Exercise 3: Searching for a Library Component
In this exercise, you search for a tool library component using the Search window.

1. Select Search on the Home tab.

Mastercam ToolManager Tutorial—1: Working with Tool Library Files (.TOOLDB)



The Search window displays.

2. Select Tools on the Home tab.

In this exercise, you are searching for a specific tool.

3. Select items from the Search Item and Condition drop-down lists, and enter
appropriate search criteria in the Value field to further narrow (filter) your
search. For this exercise, enter values as shown below:

As soon as you choose a Search Item, a new row in the datagrid appears,
allowing you to search by more than one Search Item. To remove a line of
search criteria, select it and press [Delete].

4. Select Search to display your search results.

Mastercam ToolManager Tutorial—1: Working with Tool Library Files (.TOOLDB)
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5. Your search results should be similar to the image below:

These results are automatically added to your Recent Search list, accessed by
selecting Recent. To execute the search through shortcut keys, press [Ctrl] +
[Enter].

To add an item to a database already open in Tool Manager, drag the item
from your SearchWindow and drop it into Tool Manager's Database Explorer.
The item is added to the appropriate document.

6. Select Favorite on the Home tab. This saves the search as a favorite for future
reference.

7. Enter FlutesMetricDiameter for the name of the search, and click Add.

8. The name of the saved Favorite is listed in the Favorites folder:

Mastercam ToolManager Tutorial—1: Working with Tool Library Files (.TOOLDB)



9. You can also use the Default Searches, provided with the Tool Manager, to
open common database searches.

10. Exit the Search window.

Mastercam ToolManager Tutorial—1: Working with Tool Library Files (.TOOLDB)
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Working with Components in a Tool

Library

In this lesson, you learn how to create and edit tool library components.

Lesson Goals
l Create and edit tools, holders, and assemblies

l Use the graphics window display to edit assemblies

l Add and edit materials and cut parameters

2



Exercise 1: Creating a New Tool
In this exercise, you create a new tool.

1. If necessary, open the ToolManagerTutorial_XXX.tooldb file.

2. Select the Bull-Nosed Endmill tool type in the New Milling group.

The Tool Wizard displays.

3. In the Define Tool Geometry page, change the following parameters:

l Overall length to 85.

l Cutting length to 30.

Mastercam ToolManager Tutorial—2: Working with Components in a Tool Library
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4. Ensure that your other parameters match those shown in the image below.
The tool image updates as youmake changes.

5. ClickNext to work in the Finalize Properties page.

6. In the Finalize Properties page, make the following changes:

l Set Tool number to 1.

l Set Length offset to 21.

l Set Diameter offset to 41.

Mastercam ToolManager Tutorial—2: Working with Components in a Tool Library



7. Ensure that your other parameters match those shown in the image below.

8. Click Finish to save your changes. This adds the new tool to the open library,
and closes the Tool Wizard.

Exercise 2: Creating a New Holder
For this exercise, you create a new tool holder.

1. SelectHolder on the Home tab.

Mastercam ToolManager Tutorial—2: Working with Components in a Tool Library

28



29

The Holder Wizard displays.

2. In the Define Holder Geometry page, change the following parameters:

l SetUpper Type to CAT.

l SetUpper Size to 30.

3. Press [Enter]. This displays and highlights the holder that matches your
entered parameters.

4. Ensure that your parameters match those shown in the image below.

Note: If you need to add and define a new segment, select Add Segment and
define the segment parameters in the database grid. To remove a segment,
select the leftmost cell for that row and press the [Delete] key.

5. SelectNext.

6. Enter TUTORIAL MAIN HOLDER in the Description field and select Thru
coolant to set the coolant option to flow through the holder.

Mastercam ToolManager Tutorial—2: Working with Components in a Tool Library



7. Select Finish to save your changes. This adds the new holder to the open lib-
rary, and closes the Holder Wizard.

Exercise 3: Editing Existing Tools and Holders
In this exercise, you edit a tool through the Tool Wizard. Editing a holder is similar so it
is not covered. The only difference is, when you edit holders, you work in the Holder
Wizard as described in the previous exercise.

Note: In addition to editing tools and holders, you can also select a component in the
document, and edit its properties in the Properties Grid.

1. Open the Tools document and double-click tool number 463 (3. FLAT
ENDMILL).

The Tool Wizard displays.

Mastercam ToolManager Tutorial—2: Working with Components in a Tool Library
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2. In the Define Tool Geometry page, change the following parameters:

l Set Cutting diameter to 5.

l SetOverall length to 50.

l Set Cutting length to 25.

l Set Shoulder length to 30.

Note: If you see a message in the graphics display similar to the one shown
below, ignore it for this exercise. As you complete entering the values, the
error messages are replaced with the tool graphic because you have resolved
all geometric property conflicts.

Mastercam ToolManager Tutorial—2: Working with Components in a Tool Library



3. Ensure your parameters match those shown in the image below:

4. SelectNext.

5. Set the following parameters:

l Set Tool number to 2.

l Set Length offset to 22.

l Set Diameter offset to 42.

l Enter FLAT ENDMILL - TUTORIAL inName.

6. Select Finish to save your changes.

Mastercam ToolManager Tutorial—2: Working with Components in a Tool Library
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Exercise 4: Creating and Editing Assemblies
Create assemblies using a drag and dropmethod, as described in the following pro-
cedure. Although here you only add one holder to the assembly, you can addmultiple
holders as segments of a single holder using the same drag and dropmethod.

1. Select Assemblyon the Home tab. This opens the Assembly Tree pod and the
Assemblies document.

2. Select the Holders document.

3. Drag and drop the holder, C4E4-1000, from the Holders document into the
Assembly Tree.

4. Drag and drop the tool, 23. CBORE, from the Tools document into the
Assembly Tree.

Mastercam ToolManager Tutorial—2: Working with Components in a Tool Library



5. View a graphical representation of your assembly in the graphics window by
clicking the top line of the assembly.

The following steps shows how to change a tool in an assembly. This same process
applies to any component type in assemblies.

Mastercam ToolManager Tutorial—2: Working with Components in a Tool Library
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6. Select the 23. CBORE tool in the Assembly Tree and press the [Delete] key.

7. Drag and drop the tool, 12.6 CBORE, from the Tools document into the
Assembly Tree.

As you add and remove assembly components, the name of the assembly
changes.

Mastercam ToolManager Tutorial—2: Working with Components in a Tool Library



Editing Assemblies in the Graphics Window
Besides editing assemblies by changing settings in the Properties Grid, you can repos-
ition the assembly (or its extensions) along the center line of the tool in the graphics
window.

1. In the Assembly document datagrid, select the assembly you worked on in the
previous exercise.

2. In the graphics window, place your cursor over the holder, hold down the [Ctrl]
key, and click the holder. The assembly is highlighted and a dynamic ruler dis-
plays.

The ruler always displays absolute dimensions, whichmeans that the tool pro-
jection value is always measured from the tool tip to the face of the holder.

When you hover over the holder, press the [Ctrl] key to have the cursor indic-
ate this mode. If the cursor does not change, youmay need to click the holder
to put focus in the graphics window.

3. Once the ruler displays, move your mouse back and forth along the center line
of the tool to change the length that the tool extends from the holder. You will
see the dynamic ruler floating, and the tool projection value in the text box
changes with your mouse movement.

Mastercam ToolManager Tutorial—2: Working with Components in a Tool Library
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4. Click anywhere off the tool or holder in the graphics window to set the pro-
jection distance of the tool.

When working with assemblies, you can change the Tool Projection value in the graph-
ics window. The Tool Projection field in the Properties Grid updates as youmanipulate
the assembly graphic. You can also use the Tool Projection field in the Properties Grid
to change those values.

When the dynamic ruler is active, change the ruler increments by zooming in or out
with your mouse wheel. This is helpful if you want to be more or less precise in your
Tool Projection value. The number of graduations are appropriate to the selected
units specified in the Options dialog box.

With the ruler active, click and drag it to snap your Tool Projection value to the ruler's
incremental distance lines. The movement is only between the shoulder length and
overall length values.

Exercise 5: Adding or Editing Materials
Workpiece materials are part of the TOOLDB database files. They display in the Mater-
ials document in Tool Manager. Although you can edit some of the materials' prop-
erties in the Properties Grid, the Materials document is primarily used for reference
information when working with cut parameters.

Note: Since it isn't possible for a tool manufacturer to test every possible material for
every tool, the workpiece materials specified in a tool library may not match the actual
material for a given job. Use the ISO group property to find a suitable cut parameter
setting as a starting point.

1. SelectMaterial on the Home tab to display the Materials document.

2. Select theMaterials document to view the materials grid.

3. Select the first row in the data grid and set the following parameters in the
Properties grid:

Mastercam ToolManager Tutorial—2: Working with Components in a Tool Library



l Enter Aluminum for Name.

l SetHardness to 60.

l SetHardness Units to Rockwell B Hardness.

l Set ISO Group Value toN - Aluminum, Copper, and Non-Metallic.

4. To edit the materials properties for that same material, change the following
parameters:

l Enter Aluminum - 6061 for Name.

l SetHardness to 95.

l SetHardness Units to Brinell Hardness Scale.

Mastercam ToolManager Tutorial—2: Working with Components in a Tool Library
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Your changes are automatically saved to the database.

Exercise 6: Adding and Editing Cut Parameters
Cut parameters are also part of the TOOLDB database files. They display in the Cut
Parameters document, where you can edit them as needed. These parameters are
primarily used in Mastercam when you import cutting speed and feed per tooth data
into an operation.

1. Select Cut Parameters on the Home tab to display the Cut Parameters doc-
ument.

2. Select the Cut Parameter document to view the materials grid.

3. Select the first row in the Cut Parameters document and set the parameters in
the Properties Grid:

l Enter Aluminum - 6061 forMaterial Name.

l Ensure thatMetric is checked.

l Enter Shouldering Aluminum with 16mm Endmill for Name.

Mastercam ToolManager Tutorial—2: Working with Components in a Tool Library



l SetOperation Type to Shouldering.

l Set Feed Per Tooth to 0.075.

l Set Rough Axial Depth of Cut and Finish Axial Depth of Cut to 10.

l Set Rough Radial Depth of Cut and Finish Radial Depth of Cut to 8.

l Set Surface Speed to 90.

l SetMaximum Diameter to 18.

l SetMinimum Diameter to 16.

Notes:

l Some of the fields are automatically populated and non-editable because that
information comes from the material you choose.

l If you are creating a new database or if the desired workpiece material does
not exist, you need to create the material before creating the cut parameters.

Mastercam ToolManager Tutorial—2: Working with Components in a Tool Library
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Exercise 7: Accessing Cut Parameters from Mastercam
In this exercise, you apply the cut parameters you created to a Mastercam toolpath to
update the surface speed and feed per tooth values.

1. Start Mastercam 2018.

2. Open the part file Dynamic_Mill_Rest, provided with this tutorial.

3. Select File, Save As, and save the part as Dynamic_Mill_Rest_XXX,
where XXX are your initials.

4. Select Parameters under the second operation in the Toolpaths Manager.

Mastercam ToolManager Tutorial—2: Working with Components in a Tool Library



5. Select the Tool page.

6. Right-click in the tool list and select Search for cut parameters.

The Search window displays.

7. Select File,Open, and select the ToolManagerTutorial_XXX.tooldb
file.

Mastercam ToolManager Tutorial—2: Working with Components in a Tool Library
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8. Ensure that the search criteria is as shown below:

9. Select Search. Your search results will display the cut parameter you created
in the previous exercise.

10. Select the resulting cut parameter and click Accept.

This closes the Search window, and populates the Tool page feed per tooth
(FPT) and cutting speed (CS) values with the parameter values you accepted.

11. ClickOK to accept the changes and close the dialog box.

Mastercam ToolManager Tutorial—2: Working with Components in a Tool Library



Note: The Assembly Has Changed dialog boxmay display. This dialog box
alerts you that the tool or holder has beenmodified, and is referenced inmore
than one operation in the current part file. If this dialog box displays, select
Update assembly and all operations that use the assembly and clickOK.

12. Regenerate the toolpath.

13. Save the part file, and close Mastercam.

Exercise 8: Copying Components Between Tool Libraries
Use drag and drop to copy items from one database to another. To do this, youmust
have two or more sessions of Tool Manager open concurrently.

1. Start another session of Tool Manager through the Windows’ Startmenu. You
should still have the ToolManagerTutorial_XXX.tooldb open in the
current session of Tool Manager.

2. Click the Open button and navigate to this guide’s install location.

3. Select the ToolManagerTutorial.tooldb file and clickOpen to load the
database.

4. Position the two sessions of Tool Manager side-by-side or one partly covering
the other, resizing the windows as necessary.

5. Open the Tools document in each Tool Manager window.

6. In the ToolManagerTutorial_XXX.tooldb session of Tool Manager,
select tool number 1 (12 Bull-Nosed Endmill).

Mastercam ToolManager Tutorial—2: Working with Components in a Tool Library
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7. Drag and drop the 12 Bull-Nosed Endmill onto Cutting Tools in the
ToolManagerTutorial.tooldb session of Tool Manager. Because the
copied tool has the same tool number as an existing tool, it is renumbered to
the next available number.

You can copy database items under the following drag and drop conditions:

l From one database Assemblies, Holders, Tools, Materials, or Cut Para-
meters document to another database's document of the same type.

l From any Assemblies, Holders, or Tools document in one database to the
Assembly Tree of another to build or copy new assemblies.

You can change also tool numbers by double-clicking the tool in the document
and changing the tool number in the Tool Wizard, or you can highlight the tool
in the document and change the tool number in the Properties grid.

8. Close both sessions of the stand-alone Tool Manager.

Mastercam ToolManager Tutorial—2: Working with Components in a Tool Library



46

Mastercam ToolManager Tutorial



47

Using Tools and Holders in Toolpaths

In this lesson, you learn to work in Mastercam’s classic Mill Tool Manager
using the stand-alone Tool Manager’s integrated functions.

Lesson Goal
l Edit tools and holders using classic Tool Manager

3



Exercise 1: Creating a New Tool
1. Start Mastercam.

2. Open the part file Dynamic_Mill_Rest_XXX, from the previous lesson.

3. Click the Parameters icon for the first operation in the Toolpaths Manager.

Mastercam ToolManager Tutorial—3: Using Tools and Holders in Toolpaths
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4. In the Tool page of the Dynamic Mill dialog box, right-click in the tool list and
choose Create new tool.

The Tool Wizard displays.

5. In the Select Tool Type page, select End Mill, and clickNext.

6. In the Define Tool Geometry page set the following tool parameters:

l Set Cutting diameter to 18.

l SetOverall length to 90.

l Set Cutting length to 60.

l Ensure that Shoulder length is set to 60.

l Ensure that Shoulder diameter is set to 18.

l Ensure that Shank diameter is set to 18.
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7. Make sure your parameters in the Define Tool Geometry page match those
shown in the following graphic.

8. ClickNext to work in the Finalize Properties page.

9. In the Finalize Properties page, make the following changes:

l Enter 18 Flat Endmill - Tutorial for Name.

l Enter New tool for tutorial for Description.
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10. Make sure your parameters in the Finalize Properties page match those shown
in the graphic below.

11. Click Finish to save your changes. This adds the new tool to the part, closes
the Tool Wizard, and returns you to the Tool page.

12. Do not close the 2D High Speed Toolpath - Dynamic Mill dialog box.

Exercise 2: Creating a New Holder
1. Select the Holder page.

2. SelectOpen library.

The Open dialog box displays.

3. Navigate to your ToolManagerTutorial_XXX file.
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4. Select it, and clickOpen. The Holder page will display your current library.

5. SelectNew holder.

The Holder Wizard displays.

6. In the Define Holder Geometry page, set the following parameters:

a. SetUpper Type to CAT.

b. SetUpper Size to 30.

c. Set Lower Type to ID.

d. Set Lower Size to 18.

7. Make sure your parameters in the Define Holder Geometry page match those
shown in the image below.

8. ClickNext.
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9. In the Finalize Properties page, set the following parameters:

l Enter New Holder for Tutorial for Description.

l Select Thru coolant, to set the coolant to flow through the holder.

10. Make sure your parameters in the Finalize Properties page match those shown
in the following image.

11. Click Finish to save your changes. This adds the new holder to the part, closes
the Holder Wizard, and returns you to the Holder page.

You can see the new holder is added to the list, but not yet saved to the library.
This is indicated with a message in the window and an asterisk next to the new
holder name.

12. Click Save library and save your tool library.

13. ClickOK in the Dynamic Mill dialog box. This marks the toolpath dirty.

14. Click Regenerate all dirty operations to regenerate the toolpath.
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15. Save the part file.

Exercise 3: Editing Tools and Holders
In this exercise, you edit a tool and holder inside of an operation in Mastercam.

1. Open the part file, Dynamic_Mill_Rest_XXX from the previous exercise, if
it is not already open.

2. Select Parameters under the second operation in the Toolpaths Manager, and
go to the Tool page.

3. Right-click tool #476 and choose Edit tool.

The Tool Wizard displays.

4. In the Define Tool Geometry page, change the Shank diameter to 22.

5. Click Finish to save your changes. This closes the Tool Wizard, and returns you
to the Tool page.
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6. ClickOK in the Pocket dialog box.

7. Select Parametersunder the first operation in the Toolpaths Manager.

8. Select the Holder page.

9. Right-click on the CAT 30 - ID 18 holder and choose Edit Holder. Youmay
need to scroll down the list to locate it.

The Holder Wizard displays.

10. In the Define Holder Geometry page, clickNext to leave settings as is.
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11. In the Finalize Properties page, change the Name to CAT 30 - ID 18 -
Tutorial.

12. Click Finish to save your changes. This adds the edited holder to the part,
closes the Holder Wizard, and returns you to the Holder page.

13. Save your changes to the library as described in the previous exercise.

14. ClickOK in the 2D High Speed Toolpath - Dynamic Mill dialog box.

15. Save the part file.
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Rendering Mastercam Tools

Mastercam has the ability to define a tool using parametric properties along
with a custom profile that can be imported from a CAD file, or a part file cre-
ated in Mastercam. The parametric values are used within the toolpath cal-
culations for improved performance. The optional custom profile, when
provided, is used for stockmodel generation and collision checking in Back-
plot, Verify, andMachine Simulation. Mastercam’s Tool Wizard provides the
option of displaying both profiles for comparison.

The Tool Wizard renders the custom profile as a 3D shaded tool and over-
lays the parametric profile using a dotted line. You can toggle this behavior
to render the parametric tool and overlay the custom profile.

Lesson Goals
l Understand howMastercam renders tool profiles

l Create a new tool from a profile

4



How Mastercam Renders Tool Profiles
When you use a tool profile to create a new tool, whether you import the profile from
an external file (DXF) or from a profile stored in your part file, if you choose to create
the tool based on the Custom Tool type, Mastercam tries to approximate its para-
meters.

Occasionally, Mastercam fails to populate the Custom Tool parameters accurately.
The tool may look correct in the Tool Wizard when rendered as an imported tool and
will display as a correctly-defined tool in backplot and verify, but Mastercam uses the
tool parameters from the Define Tool Geometry page in the Tool Wizard when cre-
ating toolpaths, which do not always match the true tool profile. This can result in unex-
pected toolpath behavior such as gouging, leaving too much stock, or random airlifts.
Mastercam is using the toolpath compensation based on the parametric values rather
than the imported profile shape.

The example below shows an incorrectly defined tool from a profile stored on level
200 in the Custom_tool_Testing part file included with this tutorial. You can see
that the rendered tool that Mastercam created (shown on the left) does not match the
actual definition from the imported profile (shown on the right).

Mastercam ToolManager Tutorial—4: Rendering Mastercam Tools

58



59

Even though the rendered Imported Tool shown on the right looks correctly defined,
Mastercam uses the renderedMastercam Tool shown on the left during toolpathing.
The results of the cut are shown below, viewed from the right-side view. Because
Mastercam is compensating the toolpath to the Mastercam Tool, which is shaped like
a flat endmill and not the Imported Tool, the tool is not cutting to the surface of the
part, but rather leaving a gap. Mastercam is compensating the toolpath to the the-
oretical corner of the Mastercam Tool, even though it displays as the Imported Tool.

This can often be misdiagnosed as a toolpath problem. If you have a referenced pro-
file and/or custom tool and are seeing something incorrect in the toolpath, check your
tool definition andmake sure that the Mastercam Tool and Imported Tool match.

View this by backplotting operations 1 and 2 of the Custom_Tool part file included
with this tutorial.

To create custom tools based on profile geometry, it is almost always best to select a
tool type that most closely resembles the tool you are creating rather than basing the
tool on the Custom Tool type. By basing your custom tool on a similar tool type, you
can parametrically define the tool to match the Mastercam Tool upon which your
toolpaths are calculated.
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Exercise 1: Creating New Tools from Profiles
In this exercise, you create a new tool based on a tool profile from within Mastercam.
These tools are used in toolpaths on the part supplied with this tutorial.

1. Start Mastercam 2018.

2. Open the part file Custom_Tool, provided with this tutorial.

3. Right-click in the graphics window and choose Fit to fit the part to the screen.
Your part should look similar to the graphic below.

4. Select File, Save As, and save the part as Custom_Tool_XXX, where XXX
are your initials.
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5. Select Tool Manager on theMill Toolpaths contextual tab.

You will be creating a custom tool similar to the 0.375 Bull-Nosed Endmill tool
used in operation 4.

6. Right-click in the tool list window and select Create new tool.

The Tool Wizard displays.

7. Select the Bull Mill tool type.

The custom tool profile is created as a bull-nosed endmill.

8. SelectNext.

9. Select Import and link to custom geometry from a level.

The Select Level dialog box displays.
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10. Select level 200, and clickOK.

11. Toggle between viewing the custom tool by select Render Mastercam Tool
and Render Imported Tool. They do not match. The Mastercam Tool para-
meters need to match the Imported Tool profile.

12. On the Define Tool Geometry page, enter the following parameters:

l Set Cutting diameter to 0.375.

l SetOverall length to 2.5.

l Set Radius to 0.125.

l Set Shoulder length to 1.

l Set Shoulder diameter to 0.375.

l Set Shank diameter to 0.5

Mastercam ToolManager Tutorial—4: Rendering Mastercam Tools
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13. Ensure that your parameters in the Define Tool Geometry page match those
shown below:

Notes:

l When creating custom tools from imported profiles, Mastercam pop-
ulates the parametric fields with estimated values. However, youmust
edit these values to match the imported profile parameters. Usually
these imported tool profile parameters are retrieved in one of the fol-
lowingmethods:

l If the tool profile was created without importing it from a clearly-defined
specification, you can analyze the profile geometry in Mastercam to
obtain the values.

l If the tool profile was imported from a manufacturer, you can find the val-
ues from their web site or tooling catalog.
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l If you have a tool but do not know the origin of that tool, you can obtain
the parameters using a tool setter to measure the tool values.

14. Toggle between viewing the custom tool as a renderedMastercam Tool or a
rendered Imported Tool. You can see that the rendered shapes match, show-
ing that the Mastercam Tool that is used to create the toolpath has the same
profile values as the Imported Tool.

15. SelectNext and edit the parameters as shown below, renumbering the tool as
needed.
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16. Select Finish. Since you have changed the new tool with a number already
assigned to a tool in the current library, a warning will appear, as shown below:

17. ClickOK to add the similar tool. Tool libraries allowmultiple tools with the
same number.

18. ClickOK in the Tool Manager to accept your changes.
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19. To view a similar, correctly-defined tool, backplot the fourth operation, rotating
the part to view the corrected toolpaths. The tools now cut accurately and you
can see that the new parametric tool definitionmatches the tool profile used in
Backplot, tracing the surface as expected.
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Conclusion

Congratulations! You have completed the Mastercam Tool Manager Tutorial! Now that
you have mastered the skills in this tutorial, explore Mastercam's other features and
functions.

Youmay be interested in other tutorials that we offer. Mastercam tutorials are being
constantly developed, and we will addmore as we complete them. Visit our website,
or selectHelp, Tutorials from the File tab.

Mastercam Resources
Enhance your Mastercam experience by using the following resources:

l Mastercam Documentation—Mastercam installs a number of helpful doc-
uments for your version of software in the Documentation folder of your
Mastercam 2018 installation.

l Mastercam Help—Access Mastercam Help by selectingHelp, Contents from
Mastercam's File tab or by pressing [Alt+H] on your keyboard.

l Mastercam Reseller—Your local Mastercam Reseller can help withmost ques-
tions about Mastercam.

l Technical Support—Our Technical Support department (860-875-5006 or
support@mastercam.com) is openMonday through Friday from 8:00 a.m. to
5:30 p.m. USA Eastern Standard Time.

l Mastercam Tutorials—We offer a series of tutorials to help registered users
become familiar with basic Mastercam features and functions. Visit our web-
site, or selectHelp, Tutorials fromMastercam's File tab to see the latest pub-
lications.

l Mastercam University—Mastercam University, an affordable online learning
platform, gives you 24/7 access to Mastercam trainingmaterials. Take
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advantage of more than 180 videos to master skills at your own pace and help
prepare for Mastercam Certification. For more information onMastercam
University, please contact your AuthorizedMastercam Reseller, visit
www.mastercamu.com, or email training@mastercam.com.

l Online Communities—You can find a wealth of information at www.-
mastercam.com. For tech tips and the latest Mastercam news, follow us on
Facebook (www.facebook.com/mastercam), Twitter
(www.twitter.com/mastercam), or Google+ (plus.google.com/+mastercam).
Visit our YouTube channel to see Mastercam in action
(www.youtube.com/user/MastercamCadCam)! Registered users can search for
information or ask questions on the MastercamWeb forum,
forum.mastercam.com, or use the knowledgebase at kb.mastercam.com.

Contact Us
For questions about this or other Mastercam documentation, contact the Technical
Documentation department by email at techdocs@mastercam.com.
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ATTENTION! UPDATES MAY BE AVAILABLE.
PLEASE REFER TO MASTERCAM.COM/SUPPORT

FOR THE LATEST DOWNLOADS.
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